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iBright™ Analysis Software — Secure provides tools for analyzing digital images of electrophoresis
gels and western blots in a regulated setting required to support 21 CFR Part 11 compliance. This
software performs densitometry, molecular weight determination, relative and absolute quantitation,
colony counting, and purity calculations along with the ability to adjust (e.g., contrast, rotation, crop)
images.
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Invitrogen™ iBright™ SAE Software Solution for 21 CFR Part 11
Support

This section is intended to provide information for using the iBright™ SAE Software Solution for 21 CFR
Part 11. The tools necessary for supporting 21 CFR Part 11 technical compliance include:

Creating and maintaining user accounts

Managing and enforcing password policies of all accounts
Assigning, managing, and enforcing access rights to all accounts
Documenting and maintaining audit and e-Signature history

Permitting e-Signature approval for data verification

The 21 CFR Part 11 regulation describes the criteria for acceptance by the Food and Drug
Administration (FDA) for electronic records and electronic signatures. Part 11 is composed of
procedural and technical requirements. Procedural requirements are the standard operating procedures
instituted by the end user; technical requirements are the functional characteristics of the compliance
management software used.

To implement the iBright™ SAE Software Solution for 21 CFR Part 11 support on iBright™ Imaging
Systems, you need the following components installed, activated, and communicating:

SAE Administrator Console — With the iBright™ imager and Analysis Software application profile,
used to configure the SAE settings for iBright™ Imaging Systems

iBright™ SAE License — Used to activate the SAE settings for the iBright™ instrument and iBright™
Analysis Software — Secure

iBright™ Instrument - SAE mode — Firmware connected with the SAE Administrator Console

iBright™ Analysis Software - Secure — Desktop analysis software connected with the SAE
Administrator Console

The combination of this technical offering does not guarantee 21 CFR Part 11 compliance alone.
Compliance is the consequence of the end user's work process and systems used.

Software installation guidelines

Follow the appropriate software installation instructions based on whether you are using a Windows™
operating system (PC) or Mac operating system (Mac).

Software installation, updates, and system requirements (PC)

System Requirements for PC
System Configuration Windows™ 8, 8.1, 10, or 11 with 64-bit['] operating system
Minimum RAM 8 GB
Internet Connectivity Required only for software download for installation and updates

' The 32-bit configuration is only supported up to version 4.0 of the iBright™ Analysis Software.
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Downloading the Installer

Note: The user must log in as an administrator to install the software.

1. Find the iBright™ Analysis Software installer at thermofisher.com/ibrightanalysis.
2. Fill out the webform.

3. On the webform thank you page, download the PC-specific installer (iBrightAnalysisSoftware.exe file).

Installation Process

Open the PC-specific iBrightAnalysisSoftware.exe installer file.
Accept the terms and conditions (End User Licensing Agreement).
Click Install.

Launch the application from the shortcut created on the desktop.

P w N2

Software Update

If connected to the | When first opening the software, a window will appear indicating a new software
internet version is available. Follow the prompts to install the new version.

If not connected to | You will have to occasionally check to see if software updates are available. Go to
the internet Help menu » Check for Updates and follow the prompts to install the new version.

Uninstallation Process for PC

Note: The user must log in as an administrator to uninstall the software.
In the Windows™ control panel:
1. Click £ (Settings) » Apps » Installed apps.

2. From the list of apps/programs, find the iBright™ Analysis Software row.
3. Right-click the iBright™ Analysis Software row and click Uninstall.

Software installation, updates, and system requirements (Mac)

System Requirements for Mac
System Configuration macOS™ 12: Monterey, macOS™ 13: Ventura, macOS™ 14:Sonoma
Minimum RAM 8 GB
Internet Connectivity Required only for software installation
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Downloading the Installer

o> 0bd

Find the iBright™ Analysis Software installer at thermofisher.com/ibrightanalysis.

Fill out the webform.

On the webform thank you page, click the Mac-specific installer link to download the file.
Open the Download folder.

Double click the iBrightAnalysisSoftware.zip file to extract the contents.

Installation Process

AN O

Note: The user must log as an administrator to install the software.

Open the download folder and double click iBrightAnalysisSoftware.zip to extract the files.
Open the iBrightAnalysisSoftware.pkg file.

Note: You will see a pop-up window if the Xcode™ software command line tool is not installed on your
system. Accept the Xcode™ license and install the software.

Note: For installation of macOS™ softwares, right-click on the iBrightAnalysisSoftware.pkg file and
open.

Accept the terms and conditions (End User Licensing Agreement).

Click Install.

A prompt will ask for your password to install the application.

Launch the application from the Applications folder.

Software Update

If connected to the | When first opening the software, a window will appear indicating a new software
internet version is available. Follow the prompts to install the new version.

If not connected to | You will have to occasionally check to see if software updates are available. Go to
the internet Help menu » Check for Updates and follow the prompts to install the new version.

Uninstallation Process for Mac

Note: The user must log in as an administrator to uninstall the software.

Open Finder.
Select Applications from the left panel.
Right click iBright™ Analysis Software and select Move to Trash.

Remove Image Gallery

Open Finder.
Press Command-Shift-H to open the Home folder.
Delete the iBright™ Analysis Software folder.
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Activate license
1. Launch the installed application.
2. Enter the instrument serial number.

3. Enter the SAE License key provided.

Note: The same SAE License key used to activate the iBright™ imager SAE mode is used for the
iBright™ Analysis Software — Secure.

IMPORTANT! A single iBright™ SAE License must be purchased by your institution, and the
license request submitted prior to activating.

4. Click Activate.

Connect to the SAE Administrator Console (SAE Admin
Console)

The SAE Admin Console and iBright™ Analysis Software — Secure should be installed on a
computer/location with a static IP address before connecting to the SAE Administrator Console.

1. Enter the IP address and port of the SAE Admin Console location.

Note: IP address and port location (e.g., 10.X.X.X:8201/admin-console/index.html) are available in
the address bar of the SAE Admin Console.

2. (Optional) Select Test Connection to confirm that the connection information is correct.

3. Click Save.

Note: SAE server configuration can be changed from the login window or within the application
from the & » Change server configuration. If the changed configuration redirects to a different
server, then the audit data for existing images will not be present in the new configured server.
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Sign into iBright™ Analysis Software — Secure

Note: Only user accounts with appropriate permissions created in the SAE Admin Console can access
the iBright™ Analysis Software — Secure and its features. Contact your SAE Administrator to create an
account.

1. In the login screen, enter your username and password.

2. Click Sign in.

Note: Depending on your institution's policies and settings defined in the SAE Admin Console,
users may be required to update their password upon signing in.

Clicking on & shows the username in the drop-down menu.

Sign out of iBright™ Analysis Software — Secure
1. Click &.

2. Click the logout option in the drop-down menu.

Change password

1. Click &.
2. Select Change Password.

3. Enter the password information and click OK.

Note: Your password must meet the complexity standards set in the SAE console. Contact your
SAE Administrator for details.

IMPORTANT! The following symbols cannot be used in your password: + & % \

Note: The following characters can be used in addition to letters and numbers for passwords: - _
OL[I{}/~'e@#$*r=.,"":;|<>?
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Gallery

The gallery contains tools to manage your image files. You can import or export images, select images
for editing and analysis, create reports, or delete images.

Import images

The software provides flexibility to import the proprietary .g2i files from the iBright™ Imaging Systems
and E-Gel™ Power Snap Plus Electrophoresis System, .vit bitmap files from the E-Gel™ Power Snap
Electrophoresis Device and 16-bit unmodified, uncompressed .1iff files from various sources.

To import .g2i or .vit files from the Gallery tab:

1. Click Import » Import .g2i files.

2. Navigate to and select your image files.

Note: More than one file can be selected at a time for import. A pop-up window appears showing
the upload status of the selected files at the bottom right side of the Gallery screen.

Import a single tiff file

¢ C(Click Import » Import single tiff file. Navigate to and select your tiff image files.

Note: Only uncompressed, grayscale 16-bit tiff files can be imported.

Note: Multiple files can be selected for import. A pop-up window appears showing the upload
status of the selected files at the bottom right side of the Gallery screen.

Import multiple tiff files

1. Import » Import multiple tiff files. Drag and drop or browse a folder with individual channel tiff
images.

Note: A maximum of 5 channel images using the same binning can be uploaded at one time. A
combination of a folder and individual images is not possible in the software.

2. (Optional) Edit the channel name. By default, the file name is used as the channel name.

3. Select the image type from the dropdown menu.

Note: The background is selected automatically based on the selected image type. Background
selection can be changed manually by clicking on z== (White background) or Ef (Black
background).

4. (Optional) Select a false color for the channel.

5. (Optional) Click X (Delete) to remove a channel image.
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Gallery

(Optional) Click Clear All to remove all uploaded image channels.

(Optional) Edit the file name by clicking inside the text box with the default file name.

Note: By default, the date and time of import is used as the file name.

Click Apply to upload the images and create a g2i file.

Note: All imported tiff files can be viewed under the tiff import mode when filtering the gallery.

A window will appear showing the status of the imported images at the bottom of the gallery.

Import .g2i files using a designated folder in a network location (compatible with
desktop software)

A folder on a local network drive can be set up to export images from an instrument and conveniently
import them into the software. The folder needs to be created first, then the location defined in the
software as specified below. All files to be imported should be located in this folder. Files within
subfolders are not imported. Only files exported from an iBright™ instrument (SAE mode) and iBright™
Analysis Software — Secure can be imported by this method.

1.

Click Connect to network drive.

When the software is installed for the first time, or no images are present in the Gallery, the
Connect to network drive option will be displayed on the landing screen.

Click Browse to define the path in the network drive pop-up menu.
Select the desired folder location.

Click Connect.

Any .g2i files present in the network drive folder will be synced with the software and displayed in
the Gallery. The Gallery will be automatically refreshed after every 5 successful file imports. After
all the files are synced, the total number of files imported will be displayed. In addition, any files
that failed to import will be displayed in the import window in the bottom right corner.

Click ) (Synchronize) in the Gallery to sync the new files added after the initial network drive set
up.

(Optional) Click Edit network drive to change the network drive location synced with the Gallery.
Click Change and select the new network drive location.

Note: All previously imported images are retained in the Gallery.

(Optional) Click Disconnect in the Edit network drive window to disconnect the network drive
from the software.

Note: Only one network location can be connected with the software. Upon reconnecting the
previously disconnected location, or if the location was edited, then only new files from the last
sync date will be synced. Older files will not be synced again.

iBright™ Analysis Software — Secure
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Import files from non-SAE systems or files with audit gap

Only users with permission to import files from non-SAE systems are allowed to import these files. Files
from non-SAE systems and files with audit gap cannot be imported as part of a batch import or synced
from a network folder. Files exported from the following systems are imported as non-SAE files:

iBright™ instruments not configured in SAE mode

Files exported from the desktop-version iBright™ Analysis Software or cloud-based iBright™
Analysis Software

Invitrogen™ EGel™ Power Snap Electrophoresis System (.vit)

. Click Import.

Navigate to and select your file.

Enter a reason to import the non-SAE file or file with audit gap.

Note: A reason can be selected from the drop-down list or a custom reason can be added by
clicking the Custom reason checkbox.

(Optional) Add a comment.

Click Submit.

Note: Non-SAE files imported will be converted to a secure file by the software. For a file with
audit gap, audit gap will be acknowledged by entering a reason that is then logged in the software
audit log as well as the SAE Admin Console.

Importing errors are indicated by the following icons:

?©) — Non-SAE file
&2 — Audit gap
& — Corrupted file

File status

The status of a file is displayed on thumbnails in the Gallery, list view, and all tabs. Files in the software
can be in one of the below states:

Uncommitted: File state indicated by ® representing changes that have not yet been logged in
the Audit log

Committed: File state indicated by ' representing that all the changes are logged in the Audit log.

Committed and Partially Signed: File state indicated by v & representing that the file is
committed and only partially signed (i.e., all required signatures are not yet completed).

Committed and Signed: File state indicated by v & representing that the file is committed, all
required signatures are captured, and the file is completely locked.
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Manage your image gallery

By default, the image files are displayed in = = = (Grid view), and are sorted chronologically with the
newest files on top.

From the Gallery tab:
* Click ==+ (Grid view) to view image thumbnails in the gallery.

* |n the left bottom screen, click on the small, medium, or large circles ii @ HH
to change the size of the thumbnail view.

* To sort images, click the specific option from the drop-down menu to sort images by Date,
Month, Name, Size, Mode, or Recently used.

* (Click 'y (Up or Down arrows) to reverse the order of the image files. If they are sorted
chronologically, you can switch from oldest to newest, or newest to oldest. If they are sorted
by name, you can reverse the alphabetical order (A to Z or Z to A).

* Click := (List view) to view the image files in a table. Use the ', (Up or Down arrows) to reverse
the numerical or alphabetical order of the Date, Month, Name, Mode, Recently used, or Size by
selecting the option from the drop-down menu.

Note: Changes to the display settings are retained by the image gallery on subsequent use.

* C(Click > (Preview) to right of the List View option to show or hide the Image Preview.

The Image Preview shows both an enlarged view of the image, image information, and notes
below the preview.

Note: Image information can also be accessed by clicking 0 (Information) by the file name
within the Image Analysis and Annotation tabs. The File Name and Notes sections are editable.
Changes are saved upon exiting each section.

When Image Preview is on, hovering over a file record or thumbnail causes the corresponding
image to display in the image preview pane.

¢ Right-click on a thumbnail or a row in the list view to access options to export a single image or
analysis report for the selected image or delete a single file.

Search the Gallery

The image Gallery can be searched by words input into the search field at the top. The Gallery is
updated in real time as the text is typed. Further search can be refined by using the following filters:

* Search by Image Details: Toggle on the section to view search parameters.

a. Select the HDR only checkbox to search all of the HDR images in the Gallery. Only the HDR
images will be searched for the added text in the search field.

b. Select the Notes checkbox to search the added text in the notes of all the images.

* Search by Date:
a. Select a date range (From date and To date) in the Date section.

10 iBright™ Analysis Software — Secure
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b. b. Click Apply to view images in the Gallery within that date range. The added text in search
field will be searched only for images within the selected date range.

® Search by Mode:

a. a. Deselect one or more modes to restrict search to the selected modes (Chemi Blots,
Protein Gels, Universal mode, Nucleic Acid Gels, Fluorescence Blots, and Tiff Import). All
modes are selected by default.

b. Click Apply.

Note: The search function cannot use the following special characters:

. Cloudversion: " ~!1@#$ % AN&*()-+=[]\{}|;':",./<>"?
The underscore _ character is the only usable character.

. Desktop: % and '

Note: All fields are mutually inclusive. At the bottom of the Search dropdown, the file names of all
resulting images are displayed.

Images for selected modes will be displayed in the Gallery. The added text in the search field will be
searched only in the selected modes.

Select images to add to tray

Adding images to your tray at the bottom of the window makes them available to Delete, Export, or
move to the Image Analysis tab for analysis and annotation.

From the Gallery tab, in either the = = (Grid view) or := (List view):

* (Click an image thumbnail or record to add the selection to your image tray at the bottom of the
window.

Note: Hover over an image in the tray, then click the X that appears to remove it from the tray. If
you have more than 6 images in your tray, use the left and right arrows to scroll through them.

Alternatively, click on a thumbnail in the gallery at any time to remove it from the tray.
¢ (Click Delete to delete images in the tray.
* C(Click Next at the bottom of the screen, or click the Image Analysis tab.

¢ Double-click an image to add it to the image tray and open it in the Image Analysis page.

iBright™ Analysis Software — Secure 11
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Export an image for publication

12

Images exported for publication are intended for use in print or digital publications. All image
enhancements or adjustments made by the user are retained during export. Publication quality images
are not recommended for downstream analysis. If you need to analyze images using third party
software, see “Export an image for analysis” on page 13.

1.

10.

11.

Export a single image or a batch of images.

* Right-click over the image and select Single Image Export.
¢ Select Export » Batch Image Export to export all images in the image tray.

Select Publication to set parameters for publication quality image (24-bit color).
Use the menu to select JPG, PNG, or TIF as the file format for the image.

Use the menu to select 150, 300, 600, or Custom to specify a resolution in DPI (dots per inch) for
the image.

Note: The custom resolution can be set from 72-1200 DPI except for E-Gel™ 96 gels where the
resolution for image export is set to 300 DPI.

(Optional) Enter height or width value for image size. The corresponding value is automatically
calculated based on aspect ratio of the image (shown below the Image size fields).

Note: The default image size is set at 10 cm x 8 cm.

(Optional) Select the Show Layers checkbox if layers are desired.

Note: Layers are only available when the image is analyzed and not added to composite images.

(Optional) Select Show Markers to include markers (where available) on exported images.
(Optional) Select Show Annotations if annotations are present and desired.

(Optional) Select the Include Composite Image checkbox to export composite image along with
individual channel images.

Note: This option is only available for multichannel images.

Click Browse by Export Directory and define a location for export.

Click Export.

Your image automatically downloads to your selected location as a folder. The approximate exported
file size (or folder size for batch export) is shown in the bottom ribbon. This feature is also available
for exporting grayscale mode and inverted images. The channels toggled on in the view port will be
exported. The single-channel image downloads directly after single export.

Note: Changes made to the export selections are retained on subsequent use.
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Export an image for analysis

1. Export a single image or a batch of images.

* Right-click over the image and select Single Image Export.
¢ Select Export » Batch Image Export to export all images in the image tray.

2. Select Analysis.

3. Use the menu to select g2i as the file type if you plan on sharing the file.

Note: .g2i files can only be analyzed using the iBright™ Analysis Software.

4. Use the menu to select TIF as the file format for the image to analyze the image using third-party
software.

Note: The image is exported as a 16-bit grayscale, non-adjusted TIF file.

Note: When exporting for analysis, all channels in a multichannel image are exported as separate
channels.

5. Click Export.

Your image automatically downloads to your selected location as a folder. The approximate exported
file size (or folder size for batch export) is shown in the bottom ribbon.

Commit file changes

In order to track and finalize changes made in the Image Analysis and Annotate tabs, the changes
must be committed and saved. The changes can then be viewed under the Audit tab in the software.

1. Click Commit.

2. Enter the reason in the Commit window.

Note: The reason can be selected from the drop-down list or a custom reason can be added by
enabling the Custom reason checkbox.

Note: The Commit window will display depending on the SAE Admin Console settings. If Audit
mode is set to Required, entering a reason is mandatory to commit the changes. If set to
Optional, the Commit window will be displayed, but changes can be saved with or without
entering a reason. If set to Silent, the Commit window will not be displayed.

3. (Optional) Add a comment.
4. Click Commit.

Every commit creates a new version of metadata within the g2i file and is logged in the Audit Summary
table in the Audit tab. All committed actions are also sent to the SAE Admin Console and logged under
Audit action records.
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Sign a file
When all changes are done and committed, the file can be signed as per signature rules set in the SAE
Admin Console. To sign a file:
1. Select Sign file.
2. Select a signature meaning from the e-Signature meaning drop-down menu. Signature
requirements for the selected meaning will be listed in the table below.
3. To get signatures for a role, click on the unsigned link in that row.
4. Enter credentials for Username and Password. If needed, provide a comment.
5. Click Sign. The status of the signature rule will be updated in the table from unsigned to signed.
The signature log will be added to the e-Signature Summary table, and the signature status of that
version will be updated to In Progress.
6. Continue the steps to enter all of the required signatures.
Note: It is recommended to collect all required signatures on the same computer. However,
if necessary, the partially signed file can be exported and signed by other users with iBright™
Analysis Software — Secured controlled by the same SAE Admin Console. The file must be signed
sequentially in order to obtain all required signatures on the same file.
Note: Independent copies of the file are created upon import/export.
Once afile is completely signed, the signature status of the version is updated in the e-Signature
Summary table to Signed, as well as the event is sent to the SAE Admin Console.
Note: For a partially or completely signed file, all actions in the iBright™ Analysis Software — Secure will
be disabled for that particular file. To edit the signed file, click Unlock and add a comment. Unlocking a
file will make the existing signatures obsolete, and the status in the e-Signature Summary table will be
updated accordingly. Only users with permissions to unlock will be able to unlock the file.
Audit gap

The iBright™ Analysis Software — Secure detects changes that were not tracked in your SAE Admin
Console for a .g2i file (an audit gap). If an audit gap is found, then it has to be acknowledged by
entering a reason for the gap before performing further actions. A file will be checked for audit gap
during import, performing commit, signing a file, and generating a signed report. Once acknowledged,
a log will be created in the Audit Summary table and sent to the SAE Admin Console to log in the Audit
log. For any signed file, all the existing signatures will be made obsolete.

14 iBright™ Analysis Software — Secure
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Image Analysis

The Image Analysis tab contains image editing and analysis tools organized in different accordions that
can be accessed by users with appropriate permission. All tools for the specific account are shown,

but those not permitted will not be accessible. See the SAE Admin Console User Guide (Pub. No.
MANO0O019446) for more information.

From the Image Analysis tab:

* Select an image from the image tray at the left of the screen to view it in the viewport.
* Select @ by the file name to access image information for image in viewport.

* (Change the channel displayed in the viewport for a multichannel greyscale image using < or > by
the channel name on top of the viewport or use controls according to “View and edit channels” on
page 17.

¢ Change the channel selected for editing of multichannel composite images using < or > by the
channel name on top of the viewport or use controls according to “View and edit channels” on
page 17.

Note: Only channels toggled on for display from the View and Edit Channels accordion can be
changed from the top of viewport in color mode.

* Show or hide all layers using [ on top of the viewport or show/hide layers individually using
controls described in “View layers” on page 17.

* Use tools in Zoom Controls to adjust the display magnification according to “Use zoom controls”
on page 16.

¢ Use tools in Adjust Image to straighten, crop, rotate, flip, or invert an image according to
“Straighten, crop, rotate, flip, or invert an image” on page 16.

* Use tools in Analyze Image to perform analysis, edit analysis, and view/export data according to
“View and edit channels” on page 17.

* Use tools in View and Edit Channels to switch the image display between color and greyscale
modes, show/hide channels in composite image, select a channel for editing, change/apply false
color, and apply image display enhancements according to “View and edit channels” on page 17
and “Adjust image display enhancements” on page 18.

¢ Use the Save As feature to create a copy of the file before editing to retain the original file.
From the Image Analysis or Annotate tabs:
- Right-click on the viewport and select Save As.
— Click .~ (Edit) to edit the copied file name.
— Click Apply to save a copy of the image.
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Note: Images adjusted and/or analyzed on the instrument retain those changes and are displayed as

they were on the instrument. Otherwise, by default:

. The first image in the image tray is selected for viewing and editing if no image is selected in the
Gallery tray.

. Images from all modes are shown in color. No false color is applied to images other than fluorescent
images, images captured in Universal mode with false color assigned.

. The multichannel images are shown as a composite of the individual channels.

. All images are auto-contrasted for display. Fluorescent images are also auto-enhanced using
background signal correction, but this correction is not applied to grayscale images. Analysis is
performed on original images, so these corrections do not impact the raw data.

Use zoom controls

In the Image Analysis or Annotate tab, use Zoom Controls located on top of the viewport to adjust the
display magnification.

* [# - Hide layers.

{ - Pan around an image.
* i® - Use your mouse to select a portion of the image to zoom in on.
o 7'—Zoom to fit.

* Q —Zoom out.

* @ —-Zoomin.

Straighten, crop, rotate, flip, or invert an image

In the Image Analysis tab, use tools in the Adjust Image accordion to straighten, rotate, flip, invert, or
crop an image.

. ¢ — Click Straighten, and crosshairs appear over your image. Use the slider at the bottom of the
grid or the text field below the slider to rotate your image to a custom angle, then click 4§~ again
when complete.

WARNING! Straightening can alter pixel intensity values and impact data analysis.

. |1 — Click Crop, adjust the region of the image to be cropped by dragging the crop markers, click
Apply, and confirm your crop to eliminate unwanted area outside of the crop box.
Manual adjustments performed on the image prior to cropping are preserved in the cropped
version, but analysis results are not retained.
The crop function creates a new image that is automatically added to your gallery and your image
tray at the bottom of the screen. The file name of the cropped image is the same as the original file,
but with the suffix cropped added. The original image remains in the image tray.
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O - Click Rotate, then click Rotate Left or Rotate Right under the image to rotate your image by
90° increments.

I>| 4 - Click Flip, then click = Flip Vertical or [>| 4 Flip Horizontal under the image.

— Click Invert to invert the image display. If false color is applied, they will be inverted as well.
For a multichannel image, all channels in the image are inverted.

View and edit channels

In the Image Analysis tab, in the View & Edit Channels accordion:

Click @ to turn the display of individual channels on or off.
If a channel is selected for editing (see below), its display cannot be turned off.

Click [~ to select a channel to edit. By default, the first channel is selected for editing. The channel
selected for editing can also be changed by using < or > on either side of the channel name on top
of the viewport.

Click Grayscale to convert and display a fluorescence channel in grayscale.

Note: An overlay of the membrane channel can be created by clicking @ in the grayscale for
Chemi images. This feature is not available in any other mode. Only one channel is displayed in
grayscale in Fluorescent and Universal modes. The channel selected for editing will be displayed.
Selecting the color scale from the grayscale mode will revert the display back to the composite
image, as seen before grayscale selection.

View layers

Note: Layers are analysis objects such as Frames, Lanes, Bands, or regions drawn on an analyzed
western blot, protein gels, nucleic acid gels, or wells and colonies.

These functions are available for images that have been analyzed.

In the Image Analysis and Annotation tabs, click the Layers accordion:

Click Frames to view a border around the lanes of your image.
The frames are numbered from top to bottom and left to right in the viewport.

Click Lanes to superimpose a line vertically down the middle of each band in your image.
The lanes are numbered from left to right in the analysis frame.

Click Bands to view band boundaries.
The bands are numbered from top to bottom in each lane.

Click Regions to view regions selected in your image.
The regions are numbered based on the sequence in which they were created.

Click Annotations to view added annotations on the viewport.
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* (Click Markers to view marker labels on the viewport.
* C(Click Wells to view the border around a group of colonies.

* Click Colonies to view colony boundaries.

Adjust image display enhancements

In the Image Analysis tab, under the View & Edit Channels accordion, in the Image Display
Enhancements panel:

* (Click the Auto-contrast checkbox to use the software to determine optimal signal-to-noise
contrast.

¢ Click the Show saturation checkbox to highlight saturated pixels. The saturated pixels are
displayed using white for fluorescent images in color mode and red in greyscale mode, as well
as for other modes.

Note: Auto-contrast and Show saturation are channel specific.

* C(Click the Auto-enhance checkbox to view the background-subtracted image display.

Note: The Auto-enhance option is only available for fluorescent images.

Adjust display using the histogram

The histogram is a graphical representation of grayscale intensity, which is the proportion of image
pixels with certain grayscale intensity. The vertical axis represents the number of pixels and the
horizontal axis represents the pixel intensity.

When using the histogram, any adjustments made will only affect the selected channel, indicated by
in the View & Edit Channels pane and the channel name shown on top of the viewport. Adjustments
will affect the display only, and are not reflected in the data analysis.

In the Image Analysis tab, in the Image Display Enhancements panel:

1. Use the slider or the text fields below the histogram to designate the black and white signal
intensity displayed.

2. Use the gamma slider to adjust the image midtones.

3. (Optional) Click Auto-contrast to reset default values.

Assign a color to a channel

In the Image Analysis tab, in the View and Edit accordian panel:

1. Click a color swatch between @ and the channel name to open the color palette.
2. Select a new color from the color palette below.

The image will update accordingly with the new color.
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Analyze Image

The Analyze Image accordion contains tools to analyze images of western blots, gels, E-gels (agarose
gels), cell-culture/bacterial colony plates, etc. The existing analysis can be deleted and new analysis
performed using either sample-specific Auto-Analysis, Templates, or Manual mode.

Note: If analysis was performed on the instrument, the analysis will be retained and shown when the
file is imported into the software.

Analyze an image using Auto-Analysis

Auto-analysis is performed on previously unanalyzed images when you move from the Gallery to the
Image Analysis tab. When automatic analysis is performed, the signal in an image is automatically
detected using a proprietary frame, lane, and band-finding algorithm measuring band intensities.
Manual analysis can be performed on an image already analyzed in the Automatic mode.

* “Analyze an image using manual mode” on page 30
* “Edit frames” on page 19

¢ “Edit lanes and bands” on page 20

* “Perform molecular weight analysis” on page 23

* “View and export analysis data” on page 32

* “Normalize the data” on page 26

Edit frames

* To edit or draw a frame, go to Image Analysis » Analyze Image » Western Blot/Edit
Layers » Frames.

* If not done previously, click a frame to select it.

® C(Click — (Delete) under Frames in the Edit Layers panel.

The frame and corresponding bands and lanes are deleted. You can now replace the frame with a
new one.

* (Click 4 (Add) under Frames in the tools panel.
* Use your mouse to draw a frame on the image to cover the area for analysis.

* To resize a frame, click 4+ (Add) to deselect the "add frame" selection. Select a frame to resize and
use any of the four corner "handles" to resize.

¢ Click Apply to analyze or Cancel to remove.
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(Optional) Click a frame to select, then click Ctrl+C (Command+C on Mac) followed by Ctrl+V
(Command+V on Mac) to copy and past the frame for reuse.

The pasted frames appear below the copied frame with a slight offset. If you are performing
repeated pastes and the newly pasted region reaches the image boundary, then the new frame will
be pasted over the last pasted frame.

To move a frame, select the frame and drag it using the mouse or move it using the keyboard arrow
keys.

Select Apply to analyze the frame(s) or Cancel to remove all edits.

(Optional) Click J (Skew) and drag one of the handles on the frame to adjust the position.
Skew handles can be moved up or down to create a curve if needed.

Select Apply to analyze the frame(s) or Cancel to remove all edits.

The software automatically identifies and numbers the lanes and bands within the frame.

Edit lanes and bands

You can edit lanes and bands of an image in Automatic mode.

In the Image Analysis tab, click in the Analyze Image accordion, select Automatic mode, then click
Edit Layers.

Select a lane, then click — (Delete) under Lanes or click the keyboard Delete key to delete a lane.

To select multiple lanes for simultaneous deletion, use your mouse and click-drag to draw a
selection box around the lanes of interest. Alternatively, select individual lanes sequentially using
Shift + mouse right-click.

Select 4 (Add) under Lanes, then click at the desired location within the analysis frame to add a
new lane.

Select a lane and click J (Skew) to skew a lane, pull the handles on the lane to adjust alignment,
then click _d again to deselect Skew.

Select a lane and use the keyboard arrow keys to move the lane.

Under Bands, click 4 (Add), then click at the desired location to add a band.
A band is added. If a lane did not previously exist at the location, a new lane will also be added.

Select a band, then click — (Delete) under Bands or click the keyboard Delete key to delete a
band.

To select multiple bands for simultaneous deletion, use your mouse and click-drag to draw a
selection box around the bands of interest. Alternatively, select individual bands sequentially using
Shift + mouse right-click.

Select a band or multiple bands and resize using the corner handles.
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* Move band(s) using keyboard arrows.

* Select Apply to analyze the adjusted bands and lanes or Cancel all edits. Use Undo to remove the
last edit.

Band addition, deletion, or resizing is specific for each dye channel. Select a channel to make edits.

Use lane profile to adjust bands and perform rolling-ball background correction

Lane profile is the intensity profile plot of the selected lane. It is plotted with Intensity on the x-axis

and pixel position on the y-axis. The chart also shows the non-specific background detected by the
software in gray. By default, rolling-ball background subtraction is performed using an optimal rolling-
ball radius produced by the software to generate a lane profile. This helps to more clearly view the
band boundaries and more easily adjust the bands according to profile. Hovering over the profile graph
provides values for average pixel intensity and relative front.

In the Image Analysis tab, click Analyze Image » Automatic:

* C(Click on View lane profile at the bottom right of the Edit Layers.

Select the frame and lane to view the profile. By default, frame 1/lane 1 is selected.

Adjust a band (i.e., add, delete, move, resize). Changes will show in real-time within the lane profile.

Click Apply to save changes.

* To change the default background subtraction, enter the rolling-ball radius. Click C (Reset) to
reset the rolling ball radius.
Background from the frame will be subtracted and depicted in the profile. To use this background
correction for analysis, click Apply. The data table will update to reflect data with the background
correction applied.

Note: By default, the rolling-ball radius changed for one frame will be applied on all frames and all
channels. To apply rolling-ball radius change on a single frame and single channel, click All Frames
& Channels in the tool area and then click Apply.

* You can show/hide the tool area in Lane Profile using ». You can adjust the area of the image and
lane profile screen by dragging right or left.

¢ (Optional) Toggle off Background to view the profile without the background subtraction.

* (Optional) Change the channel to view the profiles of lanes in other channels. No lane profile will be
displayed for the TPN channel.

Background designation for signal detection

This feature allows the user to change background designation for signal recognition. When === (White
Background) is selected, the algorithm detects black signal on a white background. When EE (Black
Background) is selected, the algorithm detects white signal on a black background. If the background
of the image is manually changed, the image is reanalyzed accordingly.
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Perform relative or absolute quantitation

22

Determine the relative quantity of signals

Assigning a band or volume region as a relative reference allows comparison of local background
corrected volume of the reference area to all other bands and regions on the image. Performing this
task normalizes all bands/regions to one band/region of interest. This is a useful tool for comparing
experimental samples to a control, where fold-change is interpreted by data normalization.

Relative quantity is the ratio of the region or band volume divided by the relative reference region or
band volume. This analysis can be performed in both Automatic and Manual modes, after you have
selected one band or one region to use as a reference. See “Determine the relative quantity of signals”
on page 22 for more information.

Relative quantitation is performed at the frame and channel level in Automatic mode, and at the
channel level in Manual mode.

In the Image Analysis tab, in the Analyze Image accordion, click Automatic or Manual.

1. Click Analysis.

2. Click Quantitate.

3. Click Relative and select a channel for quantitation.

4. Click to select one of your regions or bands as the relative reference.

5. Select the desired volume type to use for quantitation (see “Select volume type for quantitation” on
page 29) and click Apply.

Following selection of a relative reference, your data table will reflect relative quantities. The selected R
has a value of 1.

Determine the absolute quantity of signals

Assigning several bands or volume regions as absolute references with known quantities allows volume
(sum pixel intensity) quantity interpolation/extrapolation for all other bands and regions on the image.
This is a useful tool for determining amount of a sample when at least two known quantities of sample
are on the same image.

Absolute Quantity is the value obtained from the Quantity Curve. The analysis can be performed in
Automatic or Manual modes. See “Determine the relative quantity of signals” on page 22 for more
information.

In the Image Analysis tab, in the Analyze Image accordion, click Automatic or Manual.

1. Click Analysis.
2. Click Quantitate.
3. Click Absolute and select a channel for quantitation.

4. Click to select one of your bands or regions as the absolute reference.
A Standard text field appears in the quantitate pane.
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Select a unit of measurement for your standard from the drop-down menu by the test box for
standard (mg selected by default).
Enter the quantity of your standard in the text field provided.

(Optional) Select one or more additional absolute standards as references, and assign their values
as above.

Select the desired volume type to use for quantitation (see “Select volume type for quantitation” on
page 29) and click Apply.

Your data table will reflect calculated quantities based on the standards designated.

Perform molecular weight analysis

Be sure to have the correct channel selected (channel name shown on top or viewport), indicated
by (+), before designating a marker lane.

Note: Only one kind of marker (e.g., iBright™ Prestained Protein Ladder, BenchMark™ His-Tagged
Ladder, etc.) can be applied per frame.

In the Image Analysis tab, click Analyze Image » Automatic:

1.

2.

7.

Click Analysis.
Click Markers.

Click the marker lane in your image to select it.

The selected marker lane and bands turn yellow (or blue if the image has a light background). The
marker list will show the last 3 markers used with a custom marker list and a default marker list.

Select a marker from the 2nd dropdown menu.

See “Add a custom marker to your analysis” on page 24 for information how to create a custom
marker.

The software automatically designates standard sizes to bands, according to the marker selected,
in descending order. If the software recognizes more bands than there are standards, it will exclude
the smallest size bands. If there are fewer bands than standards, the smallest standards are left off.
Band assignment happens in descending order.

(Optional) Select and deselect extra bands from the list of markers.

The deselected bands no longer display yellow. In case the software detects more bands than
available standards, click on the extra bands in Image to deselect them.

(Optional) Adjust the marker designations or click X next to any band incorrectly designated a
marker band.

Click Apply.

You can now view your data as a graph (see “View your data as a graph” on page 25).
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Add a custom marker to your analysis

In the Image Analysis tab, in the Analyze image accordion, under Automatic:

1.

2.

9.

Click Analysis.

Click Markers.

Click Add/Edit Custom Markers and then click Add to create a new marker.
Enter a custom marker name. Use only alphanumeric characters.

Select Protein, DNA, or RNA from the Marker type drop-down menu.
Select the units for the marker, depending on marker type.

Select the number of marker values.

Enter a marker weight for each band, and click Save.

Click X to exit the custom marker creation/editing workflow.

Your custom marker will be added to your list of custom markers, and can be selected and applied to
your image. See “Edit or delete a custom marker” on page 24 for more information.

Edit or delete a custom marker

In the Image Analysis tab, in the Analyze Image accordion, under Automatic:

1.

2.

24

Click Analysis.
Click Markers.
Click Create/Edit Custom Markers.

Click [ # ] to select a set of custom markers in the Custom Markers list.
(Optional) You can delete the marker here by clicking Delete, then confirming deletion.

Edit marker parameters such as Name, Marker type, Units for this marker, or Number of
marker values.

Adjust designhated marker weights as necessary.

Click Save.
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View your data as a graph

Once you have assigned marker bands to your image (see “Perform molecular weight analysis” on
page 23), you can view your data as a graph.

In the Image Analysis tab, in the Analyze image accordion, under Automatic:

1. Select Analysis » Marker from the drop-down menu.

2. Click Graph.

The graph opens. Select a lane on the image to view the corresponding data on the graph. The
chosen regression method will be saved as a preference for the next marker analysis.

3. Select a lane or band on the image to view the corresponding data on the graph.

4. (Optional) Select Regression » Linear or Linear Semi Log to change the regression method used.
View the R-squared Value to determine the "goodness of fit” for the chosen regression method.

See “Regression methods” on page 25 for more information.
5. Click Apply at the bottom of the chart area to apply the new regression method selected.

6. Select another frame in the image to see the graph for that frame. Change the channel using the
drop-down menu above the chart.

7. Click Apply to save changes or Cancel to remove the changes.
8. (Optional) Click Data to view the data table.

Click X at the top of the screen to return to the to return to the Marker Analysis screen.

Regression methods

Point To Point — This regression method determines the slope of the line between two markers.
Therefore, no single equation and no R? term are available for this method. The log of the molecular
weight values of the markers is used to generate the slope between each pair of markers.

Linear - This regression method determines molecular weight by a linear equation: y = ax + b, where y
is the molecular weight, a is the slope of the line, x is the relative front (R;) and b is the intercept. This
linear equation is calculated with the log of the molecular weight values of the markers. This method
minimizes the sum of squared differences between an observed value and the fitted value provided by a
model.

Linear Semi Log — The linear equation is y = ax + b, where y is the molecular weight, a is the slope of
the line, x is the relative front (Rs) and b is the intercept. This linear equation is calculated with the log of
the molecular weight values of the markers.

Note: In some cases the calculated molecular weight varies from visual estimation of the molecular
weight based on comparison to the two nearest markers. In such a case, changing to the point-to-point
regression method results in calculated molecular weights consistent with visual estimation.
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Normalize the data

Normalization is an analytical method wherein data within a set is mathematically corrected for
experimental variability, sample loading, and transfer efficiency using an internal control. The internal
control can be a housekeeping protein (HKP) such as actin, tubulin, or GAPDH protein that is present
in all samples or total lane protein. The total lane protein-based normalization is abbreviated as TPN
and uses the sum of the signal intensity in the lane for calculation of normalization factors. Ideally,
the internal control should be detected on the same blot as the target protein. Use of HKP for
normalization is only recommended under conditions where the expression of HKP does not change
with experimental treatment.

Normalization is performed in a multi-step process:

Identify the method for normalization (HKP or TPN).

2. Determine normalization factors for each lane.

Normalization factor for lane equals the (Observed signal of housekeeping protein or total
protein for each lane) divided by the (Highest observed or user-selected, background-
corrected volume intensity of housekeeping protein or total lane protein).

3. Divide all of band intensities within a lane individually by the normalization factor for their
respective lanes.

4. The calculated normalization factors are displayed in the tool area with the data type (volume or
background-corrected volume) also indicated.

5. (Optional) Change the data used for calculation of the normalization factor by clicking on the
Volume type used (blue text) and change the volume type from the pop-up screen and apply.
Normalization factors are updated to reflect the changes.

Normalize using HKP

In the Image Analysis tab, in the Analyze image accordion, under Automatic:

1. Click Analysis.

2. Click Normalize.

3. Click HKP (HKP is selected by default).

4. Select the channel containing normalization controls (e.g., loading controls).

5. Select a band as a normalization control and select Apply.

Note: A horizontal line appears over the selected band. All the bands falling on this line are
automatically designated as normalization controls. If the automatic band selection is inaccurate,
select or deselect bands manually.

6. Select a band to act as a reference and select Apply.
A normalization factor is generated, and bands are normalized against this factor.
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HPK Normalization is allowed across multiple frames. After confirming the reference band, select
the frame(s) that need to be normalized using the defined loading controls above. Select Apply
to confirm normalization. The frames that were normalized and the type of volume data used for
normalization are shown in the tool area.

Change the volume data used for normalization by clicking on the volume type displayed in the
tool area (see details on page 29).

(Optional) The normalization performed on all frames in that image can be cleared by selecting
Clear. Normalization on individual frames can be cleared by selecting X on the side of the frame in

the tool area.

(Optional) Normalization can again be performed on the frames for which it was cleared (see steps
5-7).

To apply the normalization factors to other images in the tray, click on Select File in the tool area.

Note: Only the files that were previously analyzed, and have the same number of frames and lanes
can be selected. Images analyzed for colony, E-Gel™ 96, and HKP cannot be selected.

Select the file(s) from the pop-up window to apply the normalization factor.

Note: Images can be added from the gallery by clicking on Add images from Gallery in the
pop-up window. A confirmation message will appear to exit the current workflow.

Click Apply to normalize the selected images.

The software will automatically normalize all of the bands of the selected image(s) using
normalization factors from the reference image. The normalization factors and reference image
are shown in the tool area of the normalized image. Normalized data is then available in the data
table.

(Optional) To edit normalization factors and reapply to the previously applied images, add the
reference image and the applied images to the tray. Edit the reference image as needed and
perform HKP across the files again (see steps 11-13).

Normalize using Total Lane Protein (TPN)

In the Image Analysis tab, in the Analyze image accordion, under Automatic:

1.

2.

3.

Click Analysis.
Click Normalize.

Click TPN.

Note: If a channel was designated as TPN during image capture, software will automatically
perform TPN for the frame using that channel as control channel. The lane with the highest
background-corrected volume will be used as the reference lane. User can change the reference
lane later.
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4.

10.

11.

12.

13.

14.

If a channel was not designated as TPN during image capture, select the channel containing total
lane protein stain (e.g., No-Stain™ Protein Labeling Reagent) and apply.

Note: Software will automatically perform TPN using the selected channel as a normalization
control. The normalization factors will be displayed in the tool area. The normalized data for bands
in all other channels is shown in the data table. To apply the generated normalization factors to
another image, go to step 10.

(Optional) Drop lanes that you don’t want normalized by selecting 4 on top of the lane.

(Optional) Change the reference lane (shown in red) by double clicking on a different lane. The new
lane will now be designated as the reference lane.

(Optional) Increase or decrease the volume of the lane used for analysis by using the handles
provided.

(Optional) The normalization performed on all frames in that image can be cleared by selecting
Clear. Normalization on individual frames can be cleared by selecting X on the side of the frame in
the tool area.

(Optional) Normalization can again be performed on the frames for which it was cleared by using
Apply TPN Option under that frame in the TPN workflow.

Note: Data is only updated after making the changes, then selecting Apply.

To apply the normalization factors to other images in the tray, click on Select File in the tool area.

Note: Only the files that were previously analyzed and have the same number of frames and lanes
can be selected. Files used to generate TPN normalization factors cannot be selected.

Select the file(s) from the pop-up window to apply the normalization factor.

Note: Images can be added from the Gallery by clicking on Add images from Gallery in the
pop-up window. A confirmation message will appear to exit the current workflow.

Click Apply to normalize the selected images.

The software will automatically normalize all of the bands of the selected image(s) using
normalization factors from the reference image. The normalization factors used, and the reference
image, are shown in the tool area of the normalized image. Normalized data is then available in the
data table.

Change the volume data used for normalization by clicking on the volume type displayed in the
tool area (see details in “Change volume data used for normalization” on page 29).

(Optional) To edit normalization factors and reapply to the applied images, add the reference image
and the previously applied images to the tray. Edit the reference image as needed and perform
TPN across the files again (step 10-step 12).

Note: If the applied image is not present in the tray, it can be added by clicking Applied Images
in the tool area of the reference image and clicking the image thumbnail in the pop-up window.
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Change volume data used for normalization
Volume type selection for Normalization:

In the Image Analysis tab, in the Analyze image accordion, under Automatic (Auto analysis/manual
frame) » Normalize:

* Perform HKP/TPN according to “Normalize using HKP” on page 26 and “Normalize using Total
Lane Protein (TPN)” on page 27.

¢ Click on Volume type link from the tool area to change the volume type from the local bg. corr.
volume.

Note: Default volume for the TPN channel is rolling ball bg. corr. volume.

* Select any volume or local bg. corr. volume or rolling ball bg. corr. volume.

— The Select Volume pop-up is having all of the frames and channels and volume drop-down for
all channels.

— You can select different volumes for different channels for a single frame.

— For frames where normalization is not performed, volume selection is not there.

Note: Message should be displayed under frame number (e.g., TPN analysis not performed).

* (Click Apply.

— The data is recalculated for changed channel/frame based on volume selected and reflected in
data table.

— If the selected background correction is deleted, then by default data gets recalculated using
default volume (local bg. corr. volume).

— If normalization is performed on a membrane channel, then data will be present for the
membrane channel in the Select Volume pop-up and data table.

— Volume selection is frame- and channel-dependent.

Quantitation

The Quantitate function contains tools for performing relative and absolute quantitation of signal.
These functions are enabled when a band or region is selected on the image.

Select volume type for quantitation
The volume type can be selected for Relative and Absolute quantitation.

In the Image Analysis tab, in the Analyze Image accordion, click Automatic or Manual » Quantitate.

1. Click Relative/Absolute.

2. Click on Band or Region to select as a reference or standard.
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3. Click on the Volume type drop-down menu in the tool area.

4.

Note: By default, the local bg. corr. volume is selected.
Volume type options include:

For Automatic mode:

. Volume

. Local bg. corr. value

. Rolling ball bg. corr. volume
. HKP normalized volume

. TPN normalized volume

For Manual mode:

. Volume

. Local bg. corr. volume
. Global bg. corr. volume

The various volume options will be present only when a respective workflow is performed.

Select volume and click Apply.

Analyze an image using manual mode

30

When you are interested in analyzing only a portion of your image, Manual mode allows you to
manually single out the signals you are interested in for analysis.

Note: Manual mode and Automatic mode can be used simultaneously on the same image.

In the Image Analysis tab, in the Analyze Image accordion, click Manual.

1.

2.

6.

7.

In the Manual pane, select Regions.
Select [ ] or () to add a square or round region.

Using your mouse, draw borders around the signal to create a region.
Multiple regions can be drawn at a time.
The software labels these regions V1, V2, and so on.

(Optional) Click a region to select it, then use Ctrl+C (Command+C for Mac) followed by Ctrl+V
(Command+V for Mac) to copy and paste the region for reuse.

The pasted regions appear below the copied region with a slight offset. If you are performing
repeated pastes and the newly pasted region is out of view, zoom out the image to access them.

(Optional) To remove a region, click to select it and then press Delete or Backspace (+ fn for Mac)
on your keyboard.

Using your mouse, move the regions to desired locations.

Click Apply to confirm the actions on the regions.

You can turn the visibility of regions on or off by clicking Regions in the layers pane.
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Perform global background correction using manual analysis

The software performs automatic local background subtraction. The raw data and the local
background-corrected data are automatically displayed in the Analysis Table. Global background
subtraction method is also available using Manual mode and rolling ball background correction (see
lane profile) using Automatic mode.

Local background subtraction — Local background subtraction is automatically performed by the
software. The average intensity of the 5 pixels surrounding the border of each band or region

is used to calculate the intensity within the band or region attributed to background. This value
is subtracted from each pixel intensity within the band or region, resulting in Local Background
Corrected Volume and Density values in the Analysis Table.

Global background subtraction — Global background subtraction designates a region as
background to be subtracted from volume regions. There are two methods to activate global
background subtraction: (1) select a background region and then associate with volume regions or
(2) select volume regions or bands to then associate with a background region. Global background
subtraction allows designation of multiple background regions for association with a subset of
volume regions on an image. For example, when analyzing an image with uneven background,

it may be necessary to designate more than one background region for subtraction from certain
volume regions of interest.

Note: For accurate global background correction, designate a background region that is equivalent
in size (pixels) to the region of interest.

In the Image Analysis tab, in the Analyze Image accordion, click Manual.

1.

2.

Click Manual » Analysis.

Click Background Subtraction.

Click Global.

Select region(s) to be designated as background.

Right-click and select the appropriate choice (to designate as background).

Select regions that you want to associate with the background region. You can select more than
one region by clicking the lasso, then Shift, and then selecting the region.

Select background region.

Right-click and select associated regions from the drop-down options to create a group of the
selected regions.

The selected background region will be used to correct the background of all the associated
regions in that group, and data will be available in the data table.

(Optional) Follow steps 6-8 to create more groups.

Note: Each group can have only one background region.
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Rolling ball subtraction - Rolling ball background subtraction designates a ball of a specific radius
that can roll over the selected lane profile and subtract the background. The smaller the rolling ball
radius, the more the background subtraction. The background-corrected image can be used for
further analysis.

In the Analyze tab of the Auto-analysis window:

In the Image Analysis tab, in the Analyze Image accordion, click Automatic » Edit Layers.

1.

Click on View lane profile at the bottom of Edit Layers.

2. Select the frame to apply the rolling ball. Frame 1 is selected by default.

3. Enter the rolling ball radius in the text field below the lane profile or increase the radius using the

slider.

Note: An optimal rolling-ball radius generated by the software is applied on all frames of the
images by default. Changing rolling ball for one frame and applying changes the value for all
frames in all channels. To apply rolling ball on a single frame, single channel, uncheck All Frames
& Channels in the tool area and then apply. Once selected, the Apply button will be disabled until
the rolling-ball radius is changed.

You can reset the radius to the default size at any time using C (Reset). After reset, the edited
radius size will not be applied for analysis until you click on Apply.

View and export analysis data

32

1.

The data table displays image analysis data, including pixel intensity and density, background
subtracted data, retention factor (R;), molecular weight (MW), relative and absolute quantities,
normalization, and band purity. Only available data is displayed. Use the Data Table icon Y to show or
hide the data columns. Changes made to the settings are retained on subsequent use.

In the Image Analysis tab, in the Analyze image accordion:

Click Data.
A table with available data opens and the image appears in the left panel. Use the dropdown menu
to select columns. The table displays the following data:

* Name - Name of the data point or grouping.

¢ Vol. (Int.) - Volume — Equals the sum of each pixel grayscale intensity in the region or the band.
The units of Volume are intensity. All pixel intensities are displayed as they would be for a
16-bit image.

* Area - The number of pixels within each region or band.

¢ Density — The average intensity per pixel or Volume divided by Area with units of
Intensity/Area.

* Mol. Wt. — Molecular Weight — Weight assigned to bands per the applied marker

* Rel. Quant. — Relative Quantity — Ratio of the region or band volume divided by the relative
reference region or band volume.

Note: You can use the following volumes for bands: (w/vol), (w/LB corr. vol), (w/HKP Norm.
vol), (w/TPN vol), and (w/RB corr. vol). For regions: (w/LB corr. vol), (w/vol), and (w/Global bg
corr. vol)
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* Abs. Quant. — Absolute Quantity — Quantity value obtained from the Quantity Curve. The
asterisk (*) changes to the mass unit selected from the Units drop-down menu in the Quantity
subtab.

Note: You can use the following volumes for bands: (w/vol.), (w/LB corr. vol.), (w/HKP Norm.
vol.), (w/TPN vol.), and (w/RB corr. vol.). For regions: (w/LB corr. vol.), (w/vol.), and (w/Global
bg corr. vol.).

* HKP (Housekeeping Protein) Norm. Factor - HKP Normalization Factor — Background-
corrected volume of the control band divided by the background-corrected volume of the
reference band.

¢ HKP Norm. Vol. - HKP Normalization Volume — Background-corrected band volume divided
by the HKP normalization factor.

¢ HKP Norm LB Corr. Vol. - HKP Normalization Local Background Corrected Volume — Local
background-corrected volume of a band divided by the HKP normalization factor.

¢ HKP Norm RB Corr. Vol. - HKP Normalization Rolling-Ball Corrected Volume - Rolling ball-
corrected volume of a band divided by the HKP normalization factor.

¢ Local Bg. Corr. Vol. — Local Background Correction Volume — Volume minus the local
background intensity. This value is automatically calculated for each band or region and
cannot be disabled.

¢ Local Bg. Corr. Den. — Local Background Correction Density — Local Background Corrected
Volume divided by the Area.

¢ Global Bg. Corr. Vol. — Global Background Correction Volume — Volume minus the global
background defined area intensity.

* Global Bg. Corr. Den. — Global Background Correction Density — Global Background Corrected
Volume divided by the Area.

* Rolling-ball Bg. Corr. Vol. — Rolling-Ball Background Correction Volume — Band intensity minus
the rolling-ball background.

* Rolling-ball Bg. Corr. Den. — Rolling-Ball Background Correction Density — Rolling-ball Bg.
Corr. Vol. divided by the area.

* TPN Factor (w/RB Corr. Val) — Total Protein Normalization Factor — Background-corrected lane
volume divided by Backgound-corrected lane volume of reference lane.

* TPN Factor (w/Vol.) - Total Protein Normalization Factor — Lane volume divided by lane volume
of reference lane.

¢ TPN Volume — Total Protein Normalization Volume — Volume of a band divided by normalization
factor for that lane.

e TPN LB Corr. Vol. — Total Lane Protein Local Background Corrected Volume - Local
background-corrected volume of a band divided by normalization factor.

¢ TPN RB Corr. Vol. — Total Lane Protein Normalization Rolling-Ball Corrected Volume — Rolling
ball-corrected volume of a band divided by normalization factor.

* % Purity (Band) — A band’s local background-corrected volume divided by the local
background-corrected volume of all bands in the lane (in that channel) multiplied by 100. If
rolling-ball subtraction has been engaged, then the % Purity (Band) is the band’s rolling-ball
background-corrected volume divided by the rolling-ball background-corrected volume of all
bands in the lane (in that channel) multiplied by 100.
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2.

* % Purity (Lane) — A band’s volume divided by the volume of the entire lane (in that channel)
multiplied by 100. If rolling-ball subtraction is engaged, then the % Purity (Lane) is the band’s
rolling-ball background-corrected volume divided by the rolling-ball background-corrected
volume of the entire lane (in that channel).

Select Export » Export Data » ';3 to export the table data as an .xls file.

Filter the data table

Filter the data table to selectively display and export specific portions of the data.

With an image displayed, click the Data tab (next to the Edit Layers and Analysis tabs) within the
Analyze Image panel.

1.

2.

4.

Click \f to open a new data table.

Add data to the new data table.

¢ (lick individual bands to add data to the table.
¢ (lick a lane to add the data for all the bands in the selected lane.

* Select multiple bands or lanes by clicking while holding down the shift key.

(Optional) Select Export » Export Data » ',;3 to export the table data as an .xls file.

Note: Only the filtered data is included in the report if the data is filtered.

(Optional) Click v to return to the original data table.

Switch sample type for analysis

34

Many different sample types can be imaged on the imager, including western blots, protein gels,
nucleic acid gels, high-throughput nucleic acid gels, such as E-Gel™ 48- and 96-well agarose gels, and
cell culture plates. Samples such as E-Gel™ 96 and cell culture plates use specialized algorithms for
analysis, therefore sample definition is required for accurate analysis.

The sample type for analysis can be changed by selecting an accurate analysis option in the tool area.
Below are the supported analysis options:

Western Blot: The analysis algorithm is optimized for frame/lane/band identification.
Gel: The analysis algorithm is optimized for frame/lane/band identification of protein gels.
Colony: The analysis algorithm is optimized for identification of wells and colonies.

E-Gel 96: The analysis algorithm is optimized for identification of wells and bands in 96-well E-gels
and analysis followed by deconvolution of image and data

E-Gel 48: The analysis algorithm is optimized for identification of wells and bands in 48-well E-gels
through default templates.
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Analyze high-throughput E-Gel™ gels

High-throughput E-Gel™ gels are available as E-Gel™ 96 gels and E-Gel™ 48 gels.

* E-Gel™ 48 gels contain 52 wells arranged in two rows with 26 wells per row. Default E-Gel™ 48 gel
templates are provided for analysis of E-Gel™ 48 gels.

* E-Gel™ 96 gels contain 104 wells arranged to maximize space. The software provides a
deconvolution feature to rearrange the wells into 8 x 13, 4 x 26, and 2 x 52 formats for easy
visualization and export. E-Gel™ 96 gels can be analyzed manually or through an auto-analysis
feature by applying a default E-Gel™ 96 gel template.

Note: The Auto Analysis option draws a default 48-well template on the image, but cannot auto analyze
E-Gel™ 48 images.

Note: To use default templates for E-Gel™ images, delete the existing frames, then click Template and
select the appropriate default template from the Choose Template dropdown menu. If the image was
captured using an E-Gel™ Power Snap instrument, then select a Power Snap default template. If the
image was captured using an iBright™ Imaging System, then select an iBright™ default template.

Auto analyze E-Gel™ 96 gels

1. Select one or more E-Gel™ 96 images in the Gallery to add to the image tray.

2. Navigate to the Image Analysis tab and click on the image you want to analyze in the image tray.
The image appears in the viewport.

3. Select E-Gel™ 96 in Automatic mode from the Analyze Image accordion menu. If you want to
reanalyze a previously analyzed gel, then select the frame in the viewport and delete it from the
Edit Layers tab in the Analyze E-Gel™ 96 accordion menu.

4. Select Auto Analysis to visualize the frame, lanes, and wells on the image.

5. (Optional) Select and move the wells, lanes, or frame using the arrow keys to ensure the wells are
correctly identified.

6. Click Apply to see the bands on the gel. The identified wells and any detected band within the
wells are removed.

7. Select the bands and move (using arrow keys), resize, or add and delete from the Edit Layers tab
to ensure that the bands are identified correctly. Click Apply to save the settings.

8. Click the data to see a non-deconvoluted data table. The data table displays the volume,
background-corrected volume, and area of each band detected in the gel. Click X to exit the
data table.

Note: The bands in the data table are numbered in sequence from the wells of the top row,
disregarding the internal wells. To identify the migration of bands from each well of the gel,
generate a deconvoluted image and data table as mentioned in subsequent steps.
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9. Deconvolute the E-Gel™ 96 image.

a. Deconvolute the image by clicking Deconvolute in the Edit layer. The viewport shows lane
boxes on the gel image. You can select and shift the lane boxes for visual clarity. This does
not affect calculated data.

b. To see a preview of the deconvoluted image and data, navigate to Analysis » Deconvolute.
® Select the deconvolution format: 8 x 13, 4 x 26, or 2 x 52.
* Type an image label.
* Select the file type from the drop-down menu.

c. Preview the deconvoluted image and data by clicking Preview. By default, the lane boxes
and bands are displayed on the deconvoluted image. If desired, you can remove them by
unchecking the layers.

d. Export the deconvoluted image and data table by clicking Export. Choose the desired folder
and click Save.

Templates

36

The Template option is present in unanalyzed images under Western Blot/Gel/E-Gel 96/Colony in
automatic and manual modes in the Analyze Image accordion.

In the Image Analysis tab, click Analyze Image » Automatic or Manual:

Click Template.
Select Existing or Custom.

Select a saved template from the Existing drop-down menu OR create a custom template using
Custom.

Note: Frame and lane editing options are present in existing and custom panes.

Create an analysis template

An option to Save as Template is available in the template workflow and can be accessed by right-
clicking in the viewport anywhere in the Image Analysis tab.

In the Image Analysis tab, click Analyze image » Automatic/Manual:

Click Save as Template in the Template (existing/custom) workflow or right-click in the Image
Analysis viewport.

Select the required options from the Save as Template window:
— Name of template (editable)
— Auto analysis/Manual analysis
- Workflows

Note: Workflows will be enabled only if they are performed on the image (other workflows will be
disabled if not performed).

Click Apply to save the template.
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Apply a template

In the Image Analysis tab, click Analyze image » Automatic or Manual:

Click Templates.

Note: The Template option is only available when no prior analysis is present.

Select the template from the Existing drop-down menu.

Select the desired options from the Save Template window.

Note: Frames and lanes will be selected in automatic analysis, and regions will be selected in
manual analysis. (Once band is selected in the pop-up window, you can select workflows.)

(Optional) Select the template drawn in the window and press Ctrl+C (Command+C on Mac) in the
viewport. Press Ctrl+V (Command+V on Mac) to paste a copy of the template in the viewport. The
copied template can be dragged and dropped on any other part of the image.

Click Apply on the viewport to apply the template.
You can view the analyzed data as per workflow selection in the respective workflow panes.

Edit a template

Once the template is drawn on the viewport, the template can be edited before applying.

Click on Frame/Lane/Region to move on the viewport.

Note: Moving the template will not delete any analysis data.

(Optional) Resize the frames/regions by using the four corner handles.

(Optional) Skew the frame/lane using the toolbar option.

Note: Skewing and resizing frames deletes bands and respective analysis data. Lanes will be
retained.

Click Apply.
— View the analyzed data as per the workflow selection in the respective workflow panes OR
click Cancel to remove the template added.

Delete a template

To delete a saved template from the existing template list:

1.

2.

In the Image Analysis tab, click Analyze image » Automatic or Manual. Click Templates.

Click the delete icon next to a template name from the existing drop-down menu.
A prompt appears in the viewport asking to confirm the delete template action.

Click Yes to delete the template from the existing template list.
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Use default templates

The software provides default templates for 6- and 12-well plates. To access the templates:

1.

Select a colony tab. Images not analyzed will display the Template icon ([B). If Automatic analysis
is present on the image, then go to the Automatic tab and click Edit Layers » Frames. Delete the
frame and click Apply to access the Template icon ([R).

Click [ (Templates) and choose a 6- or 12-well default template from the Choose Template
drop-down menu. The template is drawn in the viewport.

Resize or move the template in the viewport by clicking and dragging the rectangular boundary
around the wells. Individual wells can be moved or resized after selection.

Once the template is correctly positioned on the image of the multi-well plate, click Apply for
colony detection.

Analyze cell culture or agar plates

The cell culture or agar plate analysis uses a specialized algorithm to detect circular spots and is only
available when no Automatic analysis is present on the image. Each well within a multi-well cell culture
plate is detected separately and the signal within each well is analyzed and grouped under that well. A
well behaves similar to a frame in Frames/Lanes/Bands analysis and a colony is similar to a band.

Note:
. Wells will be labeled as W1, W2, W3, etc. starting at the top left side of the plate. Colonies will be

labeled as 1, 2, 3, etc. and are displayed with the mouse cursor hovering over the colony. Colony
numbering will be per well per channel.
Wells are common across channels. Identified colonies are channel specific.

If Automatic analysis is present on the image, then go to the Automatic tab, then click Edit

Layers » Frames. Delete the frame and click apply. This will remove all previous automatic analysis
associated with that frame. Remove all frames present on the image. In the Image Analysis tab, in the
Analyze Image accordion, click Automatic.

1.

2.

3.

38

Select the Colony tab.
Click Auto-analysis to automatically detect well(s) and colonies within the well.

Select + under Wells to draw well(s) on the image. You can draw circular wells by mouse click and
drag in the viewport.

(Optional) Draw additional wells or select a well by mouse click and copy and paste using
keyboard controls.

Click Apply for colony detection.
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Gate colonies

After auto analysis, colony identification can be further refined by applying size, intensity, and circularity
gates. Only the colonies lying between the minimum and maximum gate values are displayed and
analyzed. To apply the gates on an image with colony analysis:

1. Navigate to the Edit Layers panel in Analyze Image » Colony Accordion.

2. Select one well in the viewport by clicking anywhere within the well.
The well number is displayed in the Edit Layers panel.

3. Below the well number, sliders for the size, intensity, and circularity gates are displayed.

a. Size refers to the number of pixels in a colony. Adjust the minimum and maximum size slider
to gate out unwanted colonies by size.

b. Intensity refers to average pixel intensity of a colony. Adjust the minimum and maximum
intensity slider to gate out unwanted colonies by intensity.

c. Circularity refers to the ratio of minor radius and major radius of a colony. Adjust the minimum
and maximum circularity slider to gate out unwanted colonies by circularity.

4. (Optional) Click C (Reset) to set the gates on values obtained by auto analysis.

Note: If you add a new colony to an auto-analyzed well, the gates may readjust to include the
attributes of new colonies.

Adjust wells and colonies

In the Image Analysis tab, in the Analyze Image accordion, click Automatic » Edit layers.

* To delete wells, select Wells and click Delete. More than one well can be selected using Shift +
click. The wells and corresponding colonies are deleted.

* To delete colonies, select Colonies by selecting with the mouse or drawing a rectangle around
the area and click Delete. More than one well can be selected using Shift + click. The wells and
corresponding colonies are deleted.

¢ To add colonies, Click Add. Click on the desired area within a well to add a colony.
* C(Click Apply to analyze or Cancel to remove.

* To resize a well/colony, select a well/colony to resize and use any of the 4 "handles" to resize. On
resizing, you can change the shape from circular to elliptical.

* C(Click Apply to analyze or Cancel to remove.
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® (Optional) Click a well/colony to select, then click Ctrl + C (Command + C on Mac) followed by
Ctrl + V(Command + V on Mac) to copy and paste for reuse. The pasted well/colony appears
below the copied one with a slight offset. If you are performing repeated pastes and the newly
pasted region reaches the image boundary, then the new well/colony will be pasted over the last
pasted well/colony.

* To move a well/colony, select it and drag it using the mouse or keyboard arrow keys.

* Select Apply to analyze or Cancel to remove all edits.

Note: You cannot add, move, or resize colonies outside of the well.

View and export analysis data
The data table displays the image analysis data.
In the Image Analysis tab, in the Analyze Image accordion, click Automatic » Data.

¢ C(Click Data or Export Data from the Export drop-down menu.
The table displays data for Name, Label, and No. of colonies.

Data Table hierarchy is Channel » Well. The total number of colonies per well per channel is
displayed.

Annotate an image

Annotate allows the user to add text details such as title, lane, and band labels. Furthermore, arrows or
boxes can also be added to highlight objects, and images can be labeled from the data table or using
annotation tools.

Label an image from data table

Convenient method for labeling analysis objects such as channels, frames, lanes, bands, and regions.
The data table is available only when image in the viewport was previously analyzed.

Add text

Note: Click '} to expand the data table for easy viewing and labeling. Only frame and lane labels will
be displayed on the image in the viewport. Channel, band, and region labels will only be displayed in
the data table. Labels are exported when the data are exported and are also included in the analysis
report. Frames and lane labels are displayed in all of the channels of multichannel images.

1. Under the label column in the data table, double-click the cell to label. A text box appears.
2. Type in the text box. Click Enter or click outside the text box .

3. Control the display of lane and frame labels in the viewport by clicking on @ in the View labels
column.
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Edit text

Labels can be edited from the table by double clicking on the cell containing the label. User can
modify or delete the text.

Display annotations in the viewport using @ to control the display of the channel image.

Label an image using Annotation tools

Annotation tools allow users to label non-analyzed and analyzed images by adding text, arrows, and
boxes directly on the image. Annotations added on composite images (color mode) will be added to
the channel selected for editing (shown on top of the viewport). The channel selected for editing is also
shown by pencil mark and a blue highlight in the View & Edit Channels accordion. Annotations added
on single-channel images (grayscale mode) will be added to the composite image as well. The labels
added using annotation tools are exported with image and are included in report but are not included in
data table.

Add text

1.

2.

6.

7.

Select text option (T) from the annotation tools.

(Optional) Change the color by clicking on the color box and selecting a new color from the
drop-down menu.

(Optional) Change the text box fill color by clicking on the fill color option and selecting a color
from the drop-down menu.

Click at the desired location on viewport to add the text annotation
A text box with a cursor will appear.

Type in the desired text.
Save annotation by clicking outside the text box.

Deselect the text tool after adding all text annotations

Draw a rectangle

1.

2.

Select the box (o) option from the annotation tools.

(Optional) Change the color by clicking on the color box and selecting a new color from the
drop-down menu.

(Optional) Change the fill color by clicking on the fill color option and selecting a color from the
drop-down menu.

Click at the desired location on the view port and drag the cursor to draw the box.
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5. Click outside the box to save.
6. Deselect the tool after use.
Draw an arrow
1. Select the arrow = option from the annotation tools.

2. (Optional) Change the color by clicking on the color box and selecting a new color from the
drop-down menu.

3. Click at the desired location on the view port and drag the cursor to draw the arrow.
4. Click outside to save.
5. Deselect the tool after use.
Annotate using the line tool
1. Select the line option from the annotation tools.

2. (Optional) Change the color by clicking on the color box and selecting a new color drop-down
menu.

3. Click at the desired location on the view port and drag the cursor to draw the line.
4. Click outside to save.
5. Deselect the tool after use.
Edit annotations
¢ Edit labels (move/resize/rotate) by selecting and performing the desired actions.

* Delete labels by selecting and pressing the delete key (fn + del keys for macOS™).

Create and export analysis report

1. Click Export » Export Analysis Report or right click on the image in the viewport and select
Analysis Report.

2. (For SAE secure software version) Select Signed or Unsigned. If not fully signed, the signature
workflow may be needed.

3. Select or de-select the following features to be included in your report.

U Image
* [ Data table
* |\ Data chart
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4. (Optional) De-select Show layers to remove the display of lanes, bands, frames, and regions from
your image display.

5. (Optional) De-select Image details to remove the details for your image from the report.

6. Click Preview.
A preview is displayed.

7. Click Print/Download.

A pdf of the analysis report is created and can be saved to any location with the required name.
Retaining the .pdf extension is essential for proper opening of the file. Changes made to the settings are
retained on subsequent use.

Audit tab

Audit Summary table

The Audit Summary table contains the audit history for an image. Data is shown in the table for the
following parameters:

Parameter Definition

Version A new version is created for every commit performed. A new version is also created upon file
import and audit gap acknowledgement

Date & Time | Date and time of the commit

Username | User logged into the iBright™ Analysis Software — Secure at the time of use

Role Role of user who completed the actions

Host ID Identifies the user system hosting the iBright™ Analysis Software — Secure at the time of use

Action Actions performed or committed

Reason Identifies reason provided for import of non-SAE file, cropping a file, committing changes,
unlocking a file, or acknowledging an audit gap

Comment Any comments provided during a Commit, Delete, Unlock, or Reason to proceed
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Show Version details

The [3 (Show details) option can be used to compare any two versions in the Audit History table. If a
data file only has one version (V1), only this V1 version will be shown. In the Audit History table:

1.

Select any two versions by clicking on the respective rows. If a single version is selected, the
selected version will be compared to the preceding version, and if no row is selected, then the
latest and first versions will be compared.

Click [3 (Show details).

(Optional) Select/deselect frames, lanes, bands, regions, annotations, or markers to view/hide on
images in the comparison window. By default, all available options are selected.

(Optional) Change the channel to view differences for the selected channel in the comparison
window.

Select the Automatic or Manual tabs to display the respective data.

Audit Summary report

The Audit Summary report contains the Audit History table along with the image comparison of
selected versions and the Audit History tables. To generate the Audit Summary report:

1.

Select any two versions from the Audit Summary table.

2. Click ¥ to create and view a report.

44

The resulting Audit Summary report contains image comparisons and data tables for the selected
versions. If any one version was selected, then its preceding version data will be in the report. If no
version is selected, then the first and last version images and data will be printed in the report.

Click the download icon in the pdf viewer to download the pdf document.

Note: Your pdf report can be saved to any location with the required name. Retaining the .pdf
extension is essential for proper opening of the file.

Use the functions in the pdf viewer to print the document.
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e-Signature History table

The e-Signature History table contains the signature history for an image. Data is shown in the table for
the following parameters:

Parameter

Definition

Version

A new version is created for every commit performed. A new version is also created
upon file import and audit gap acknowledgement

Signature Date & Time

Date and time of the e-Signature

Signature Meaning

Meaning used for e-Signature

Role Role of user who completed the e-Signature

Username User logged into the iBright™ Analysis Software — Secure at the time of use

Full Name Role of user who completed the actions

Host ID Identifies the user system hosting the iBright™ Analysis Software — Secure at the
time of use

Status Shows status of the version and every e-Signature added

Comment Any comments provided during an e-Signature

Show details in the e-Signature History table

The Show details option can be used to view the image and data of a signed version. In the Audit

Summary table:

1. Select any version by clicking on the respective row.

2. Click [3 (Show details). The image and data table of selected versions will display. If no version is
selected, then Show details will display the image and data of the latest version.

3. (Optional) Select/deselect frames, lanes, bands, regions, annotations, or markers to view/hide on
images in the comparison window. By default, the objects present will be selected.

4. (Optional) Change the channel to view differences for the selected channel in the comparison

window.

5. Select the Automatic or Manual tabs to display the respective data.
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e-Signature Summary report

The e-Signature Summary report contains the e-Signature Summary table along with the image and
data table of the selected version. The e-Signature Summary report can be generated from the Audit
tab following this procedure.

1. Select any version from the e-Signature Summary table.

2. Click X to create and view the pdf document.
The resulting e-Signature report contains the image and data table for the selected version. If no
version is selected, then the last version image and data will be printed in the report.

Note: Your pdf report can be saved to any location with the required name. Retaining the .pdf
extension is essential for proper opening of the file.

3. Click the download icon in the pdf viewer to download the pdf document.

Note: Your pdf report can be saved to any location with the required name. Retaining the .pdf
extension is essential for proper opening of the file. Use the functions in the pdf viewer to print the
document.

Documentation and support

Customer and technical support

Visit thermofisher.com/support for the latest in services and support, including:

Worldwide contact telephone numbers

* Product support, including:
- Product FAQs
— Software, patches, and updates
— Training for many applications and instruments
® Order and web support
® Product documentation, including:
— User guides, manuals, and protocols
— Certificates of Analysis
— Safety Data Sheets (SDSs; also known as MSDSs)

Note: For SDSs for reagents and chemicals from other manufacturers, contact the
manufacturer.
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Limited product warranty

Life Technologies Corporation and/or its affiliate(s) warrant their products as set
forth in the Life Technologies' General Terms and Conditions of Sale found at
www.thermofisher.com/us/en/home/global/terms-and-conditions.html. If you have any questions,

please contact Life Technologies at http://www.thermofisher.com/support.
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Life Technologies Holdings Pte Ltd | Block 33 | Marsiling Industrial Estate Road 3 | #07-06, Singapore 739256
For descriptions of symbols on product labels or product documents, go to thermofisher.com/symbols-definition.

Revision history: MAN0026496 CO00 (English)

Revision Date Description
C00 26 April 2024 Editing import function for importing g2i and tiff files. Refining topics for accuracy with current software.
B.O 12 December 2022 Refining and correcting text used throughout document. Removing "HT" from "E-gel" usage where
applicable.
A0 8 April 2022 New document for iBright™ Analysis Software — Secure.

The information in this guide is subject to change without notice.

DISCLAIMER: TO THE EXTENT ALLOWED BY LAW, THERMO FISHER SCIENTIFIC INC. AND/OR ITS AFFILIATE(S) WILL NOT BE LIABLE FOR SPECIAL,
INCIDENTAL, INDIRECT, PUNITIVE, MULTIPLE, OR CONSEQUENTIAL DAMAGES IN CONNECTION WITH OR ARISING FROM THIS DOCUMENT,
INCLUDING YOUR USE OF IT.

NOTICE TO PURCHASER: DISCLAIMER OF LICENSE: Purchase of this software product alone does not imply any license under any process, instrument
or other apparatus, system, composition, reagent or kit rights under patent claims owned or otherwise controlled by Life Technologies Corporation, either
expressly, or by estoppel.

TRADEMARKS: Google Chrome is a trademark of Google LLC. Windows, Edge, and Internet Explorer are trademarks of Microsoft Corporation. OS X,
macOS, and Xcode are trademarks of Apple Inc. All trademarks are the property of Thermo Fisher Scientific and its subsidiaries unless otherwise specified.

©2022-2024 Thermo Fisher Scientific Inc. All rights reserved.
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